
Windows® VISTA, Windows 
Intel® is a registered trademark

Issued April 2015
TA Instruments
Installation Requirements for

Rheology Systems

Notice
Thank you for ordering a rheology system from TA Instruments. To ensure that installation of your system
goes as smoothly as possible and has you ready to start evaluating your sample materials as quickly as
possible, we are providing the attached installation information. It includes details regarding laboratory
space, power, and auxiliary requirements, as well as configuration requirements for the controller
(computer). Please review this information carefully and take any appropriate actions prior to the
installation date. To avoid unnecessary delays, and/or additional charges, please ensure that the
requirements specified in this document are met before your TA Instruments Service Representative
arrives. Contact your local TA Instruments Representative if you have any questions.

To arrange for installation of your system, contact our U.S. Service Department 
(302-427-4050) or your local TA Instruments Service Representative.
7, and Windows 8 are registered trademarks of the Microsoft Corporation.
 of Intel Corporation.
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Important: TA Instruments Manual Supplement
Please refer to the TA Manual Supplement to access the following important information supplemental to
this document:

• TA Instruments Trademarks 

• TA Instruments Patents 

• Other Trademarks 

• TA Instruments End-User License Agreement 

• TA Instruments Offices 
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Requirements for the Controller (Computer)
A working rheology system consists of one or more measurement instruments (for example, a DHR Series
Rheometer) and a computer configured with appropriate TA Instruments software (this latter combination
is subsequently referred to as a controller). As a customer, you have two alternatives for configuring a
controller. You can either purchase a computer and have it configured by a TA Instruments Service
representative, or you can purchase a suitable computer on your own and configure it at your site. In either
case, the general requirements which follow are the same. 

Before installing the TA Instruments software, you should ensure that the computer system meets the
following specifications:

In situations where you are supplying the computer, it is assumed that you have 
reviewed these requirements and suitably prepared the controller prior to the 
scheduled system installation by the TA Instruments Service Representative. In 
fact, you will be required to provide hardcopy verification of your system setup 
using the instructions on page 7 before an installation visit will be scheduled.

For Rheology Advantage, disable dual core processor capability (if applicable to 
your system components).

 Table 1 Computer Requirements (TRIOS [applicable to all rheometers] and Rheology Advantage 
[applicable to only AR-G2, AR2000ex, and AR1500ex])

Description Requirement

Operating System1 2

1. Install Microsoft Operating System Service Pack, Internet Explorer and/or Direct X (if required). If you 
don't have the required versions of these packages, they can be obtained through the Microsoft web site 
(at www.microsoft.com/downloads) or by using the Microsoft Windows Update mechanism (accessed 
through the Start menu or by accessing http://update.microsoft.com).

2. Regardless of the Operating System, it must be up-to-date. Outdated Operating Systems may cause a 
problem with TA software versions installation.

Supported Operating Systems: 32 and 64-bit versions of Windows Vista Business 
and Ultimate, and Windows 7 and Windows 8 Ultimate, Enterprise & Professional3

3. Home version of Windows 8, Windows 7, and/or Vista is not acceptable. Home version is missing cer-
tain functionality that is needed for optimized analyzer performance and efficiency. 

Processor Intel® Core™ 2 Duo (2.93 GHz with 3 MB L2 cache) or better

Memory ≥ 4 GB RAM 

Hard Drive ≥ 80 GB free on hard drive

CD-ROM or DVD ≥ 48X CD-ROM or DVD

Screen Resolution 1280 x 1024 (1920 x 1080 recommended) with >24-bit colors 

Graphic Memory 128 MB 

Screen (LCD) Size 19” or greater (24” wide screen recommended)



The Microsoft components .NET Framework and Visual C++ are automatically 
installed as part of TRIOS V2.0 or higher and Advantage V4.7 or higher. The 
specific versions of these components vary depending on the software package 
installed. These components support the latest software development tools used 
in TRIOS/Advantage, as a result, software installation may take longer than in 
previous versions.

 Table 2 Optional Requirements for DHR Series and AR Series Instruments

Description Required

USB II Port Required for DHR, AR-G2, and AR2000ex with ETC and Peltier Camera 
Viewer options, Small Angle Light-Scattering (SALS) Accessory, and 
Automatic Asphalt Calibration kit.

Network Card Ethernet 10Base T/100 Base TX

Additional Ethernet Card Only necessary if connecting instrument directly and need access to 
Corporate LAN.

Ethernet Cabling 10/100BaseTX Ethernet hub/switch. Must be EIA-568B Category 5+ UTP

Client-Server Protocol DHCP

Image Capture (Camera Option) DirectX 9.0 or higher

Support for Custom Reporting Rheology Advantage Navigator software only: Microsoft Word 97 or higher

Second Monitor Recommended for SALS Accessory image viewing

TCP/IP ports used: TCP: 20010, 20011 UDP: 5050, 5056

 Table 3 Additional Requirements for ARES-G2 and RSA-G2

Description Required

Network Card Ethernet 10Base T/100 Base TX

Additional Ethernet Card Only necessary if connecting instrument directly and need access to 
Corporate LAN.

Ethernet Cabling 10/100BaseTX Ethernet hub/switch. Must be EIA-568B Category 5+ UTP

Additional Networking 
Components for Windows 2000

Networking Services, as well as file and printer sharing for Microsoft 
Network and Internet Protocol (TCP/IP)

USB II Port Required for Camera Accessory.

TCP/IP ports used: UDP: 5050, 5056, 4567
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 Table 4 Additional Requirements for Instrument Control Software

Description Required

User Log-in Capability While multiple users may still use the “Fast User Switching” function when 
running Windows, only one user at a time may use the TA Instruments 
TRIOS Instrument Control Software. This limit, which is applicable to most 
programs, is a result of hardware resources that are used by each of these 
programs.
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Free Disk Space Required
To help you determine which components to install, we have provided the following table containing the
approximate amount of free disk space required for installation of the TA Instruments software.

Other Hardware Considerations
• The computer should be a new computer that is not already attached to other analytical instruments.

• Before the TA Instruments Service Representative will schedule a visit to install new instruments, 

please obtain a hard copy of the Windows® system summary as instructed below to verify that your 
system is adequate. Please fax this verification sheet along with your company identification and 
phone number to TA Instruments Service at 302-427-4054.

Obtaining Hardcopy System Verification For Windows

1 Select Programs > Accessories > System Tools > System Information from the Start menu.

2 Verify System Summary is highlighted. 

3 Select Edit > Select All, then select Edit > Copy.

4 Open Notepad or another word processing program.

5 Select Edit > Paste then File > Print.

This amount is above that required for the operating system, plus the other 
software products supplied on the installation CD-ROM. In addition, an extra 
15 MB of free disk space is required during the install process (for temporary 
install files).

Software
Instrument Control and Data 

Analysis
Full Installation 

TRIOS 384 MB (Rheology only) 592 MB (includes Thermal + Rheology)

Advantage 344 MB (Rheology only) 1058 MB (includes Thermal + Rheology)

If you print out this summary from this step you will receive all system information 
(more than 50 pages). Follow the remaining steps to copy and print only summary 
information.
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Other Software Considerations
• Peripherals (e.g., printer) must be from the known Windows operating system compatible list. (See 

Microsoft's website at http://www.microsoft.com/hwtest for the most current list.)

• TA Instruments is not responsible for resolving issues associated with connections to your corporate 
network. [See further information in the next section.]

• TA Instruments is not responsible for resolving hardware/software conflicts created by the addition of 
third party hardware or software to the computer.

System Configurations

ARES-G2 and RSA-G2
The ARES-G2 and RSA-G2 communicate with the controller via TCP/IP. If you want to connect the
instrument and controller to your in-house network, additional considerations will apply. Your MIS/IT
department should configure the Ethernet card in the controller for communication with your in-house
network.

DHR Series and AR Series
Rheometers communicate with the controller via TCP/IP. If you want to connect a DHR Series or AR
Series Rheometer and controller to your in-house network, additional considerations will apply. Your 
MIS/IT department should configure the Ethernet card in the controller for communication with your 
in-house network. 
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Requirements for the Rheology Instruments
The following sections summarize laboratory requirements by instrument. Each section contains all of the
requirements for that particular instrument. Therefore, some items will be redundant, if you have
purchased a multi-instrument system.

DHR Series Rheometers

Main Instrument
Width
Height
Depth
Weight

32 cm (12.5 in)
76 cm (30 in)
42 cm (16.5 in)
32 kg (70.5 lbs)

Electronics Control Box
Width
Height
Depth
Weight

26 cm (10 in)
48 cm (19 in)
44 cm (17 in)
14 kg (31 lbs)

Power Requirements 110–230 Vac, 50/60 Hz, 1.4 kW (Installation Category II)

Laboratory Conditions Temperature 5–40°C
80% Maximum Relative Humidity for temperatures up to 31°C, decreasing 
linearly to 50% relative humidity at 40°C.
Instrument should be located in a dust-free, vibration-free environment, away 
from exposure to direct sunlight and direct air drafts. (Pollution Degree 2 
Environment)
Maximum Altitude 2000 m (6560 ft)
The following factors should be minimized, if possible:

Vibrations from the lab bench 

Vibrations from the floor

Air Flow directed from air-condition duct work

Doors being opened and closed

Vibration from water flow to peltier/ sample plate

Room temperature variations

Magnetic impulses 

Variations in main air supply pressure

Laboratory Requirements Air Bearing Gas Pressure (air or nitrogen) must be clean, dry, oil-free compressed 
air at 345–690 kPa gauge (50–100 psig). The dew point should be –20°C or better. 
Flow rate should be 2 L/min. A 1/4 NPT female connection must be provided for 
the DHR main air supply.

Optional Motor Cooling Water 0.5 L/min (30.5 in3/min) flow if supplied from house water line; 
recirculating water bath supplied with rheometer is an alternative. Water 
temperature must be above ambient. 
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DHR-3 / DHR-2 Placement

The DHR Series base system consists of the electronics box and instrument.

Select a location for the DHR with adequate floor space. A solid rigid laboratory bench that is level and has
a minimum depth of 76 cm (30 in), and with a width of approximately 152 cm (60 in) is recommended for
the computer and electronics control box. A sturdy table, marble is preferred, with a minimum depth of 
76 cm (30 in), and with a width of approximately 61 cm (24 in) is recommended. Please refer to the layout
shown in the figure below for component placement.

DHR-3 or DHR-2 Placement Layout
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DHR-1 Placement

The DHR Series base system consists of the electronics box and instrument.

Select a location for the DHR-1 with adequate floor space and a solid rigid laboratory bench that is level
has a minimum depth of 76 cm (30 in), and with a width of approximately 182 cm (72 in). Please refer to
the layout shown in the figure below for component placement.

DHR-1 Placement Layout
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AR-G2/AR 2000ex/AR 1500ex Rheometers

Dimensions Rheometer Depth 32 cm (12.5 in), Width 30 cm (11.75 in), Height 67 cm (26.5 in) 
Electronics Depth 45 cm (17.75 in), Width 18.5 cm (7.25 in), Height 37.5 cm (14.75 in) 

Weight 29 kg (63.8 lbs)
17.3 kg (38.1 lbs) additional for controller (Electronics unit)
7.35 kg (16.2 lbs) additional for ETC accessory

Power 
Requirements

110–230 Vac, 50/60 Hz, 1.4 kW (Installation Category II)

Laboratory 
Conditions

Temperature 5–40°C
80% Maximum Relative Humidity for temperatures up to 31°C, decreasing linearly to 50% 
relative humidity at 40°C.
Instrument should be located in a dust-free, vibration-free environment, away from 
exposure to direct sunlight and direct air drafts. (Pollution Degree 2 Environment)
Maximum Altitude 2000 m (6560 ft)
The following factors should be minimized, if possible:

Vibrations from the lab bench 

Vibrations from the floor

Air Flow directed from air-condition duct work

Doors being opened and closed

Vibration from water flow to peltier/ sample plate

Room temperature variations

Magnetic impulses 

Variations in main air supply pressure

Laboratory 
Requirements

Air Bearing Gas Pressure (air or nitrogen) must be clean, dry, oil-free compressed air at 
345–690 kPa gauge (50–100 psig). The dew point should be –20°C or better. Flow rate 
should be 25 L/min. A 1/4 NPT female connection must be provided for the AR main air 
supply.
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AR-G2 Placement

The AR-G2 series base system consists of the Electronics Base and Instrument Base.

Select a location for the AR-G2 with adequate floor space. A solid rigid laboratory bench that is level and
has a minimum depth of 76 cm (30 in), and with a width of approximately 152 cm (60 in) is recommended
for the computer and electronics. A sturdy table, marble is preferred, with a minimum depth of 76 cm 
(30 in), and with a width of approximately 61 cm (24 in) is recommended for the AR-G2 rheometer. Please
refer to the layout shown in the figure below for component placement.

AR-G2 Placement Layout
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AR 2000ex, and AR1500ex Placement

The AR series base system consists of the Electronics Base and Instrument Base. 

Select a location for the AR with adequate floor space and a solid rigid laboratory bench that is level has a
minimum depth of 76 cm (30 in), and with a width of approximately 182 cm (72 in). Please refer to the
layout shown in the figure below for component placement.

AR2000ex, and AR1500ex Placement Layout
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Smart Swap™ Requirements for DHR Series and AR Series Rheometers

Peltier Plate & Pelter 
Concentric Cylinder

Water (required for Peltier) 0.5 L/min (30.5 in3/min) flow if supplied from house 
water line; recirculating water bath supplied with rheometer is alternative.

Environmental Test 
Chamber (ETC)

Purge gas flow rate should be 10 L/min (610 in3/min) at 206–690 kPa (30–100 psi).
Optional cooling liquid nitrogen at 138–207 kPa (20–30 psi).
(Not available for the AR1500ex.)

Starch Pasting Cell Water at minimum flow rate through cell of 0.2 L/min (12.2 in3/min). Maximum 
temperature 15°C. Air flow rate should be 1 L/min (61 in3/min) at 138 kPa (20 psi).

Upper Heated Plate 
(UHP) Cooling Control

See below.

AR-G2/AR 2000ex ETC 
Viewer

Compressed air cooling must be clean, dry and oil-free at 206–690 kPa gauge 
(30–100 psig). 

Flow rate 15 L/min (915 in3/min)

Pressure Cell Compressed inert gas tank up to 13.8 MPa gauge (2000 psig) with an appropriate 
regulator.
(Not available for the AR1500ex.)
High pressure hose and regulator are not supplied with the Pressure Cell option. 
Regulators and hose are available from http://w ww.buy-compressed-gas-
regulators.com or from your local high pressure gas bottle supplier.

Electrically Heated Plates Purge flow of 5 L/min (305 in3/min) inert gas.
Motor cooling gas flow of 10 L/min for temperatures above 250°C.
Optional controlled cooling with GCA (see the next page).

Asphalt Submersion Cell Full system integration requires a Julabo FP35-HE (See below) fluid circulator fitted 
with TA Instruments firmware. 

UV Light Guide If supplied without TA light source, a source with 5-mm light guide is required.

UVLED As per the Peltier Plate (above) and circulation fluid should not be below ambient.

Small Angle Light-
Scattering

As per Peltier Plate (above) and circulation fluid temperature should not be below 
ambient.

Dielectric Accessory PC with USB port.

Immobilization Cell Water (required for Peltier) 0.5 L/min (30.5 in3/min) flow if supplied from house 
water line; recirculating water bath supplied with rheometer is alternative.
Vacuum pump and pressure gauge with connection for 6mm tubing. 

MR Accessory Fluid circulator always required for operation. For distilled/deionised water, 
minimum of 0.5L/min. Thermocube or Julabo recommended for open loop 
temperature control. TA supplied Julabo available for closed loop temperature 
control: FP35HE for 5–75°C, F32HE for extended temperature operation. Always 
consult circulator manual for correct combination of fluid and temperature range.
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Upper Heated Plate Requirements

The cooling rate and minimum temperature will depend on the source of cooling. 

Gas Cooling Accessory (GCA) for Use with Electrically Heated Plates

Standard Cooling Option 
(For temperatures above 10°C

Requires circulation fluid by continuous supply from mains tap or from 
supplied fluid circulator. For fluid cooling the supply should be 5°C below the 
minimum required temperature at a minimum flow rate through the system of 
0.2 L/min.
Air: Compressed air 1 L/min at 206–690 kPa (30–100 psi).

Standard Cooling Option – using 
lab sink water supply 
(For temperatures above 10°C)

Requires circulation fluid by continuous supply from lab sink water supply. 
The water supply temperature should be 5°C below the minimum required 
temperature at a minimum flow rate through the system of 0.2 L/min.

Standard Cooling Accessory TA-supplied Air Cooled Circulator (403209.901)
Recommend fluid 100% distilled water with 1 oz. of TA conditioner added.

Low Temperature Cooling 
Accessory – Thermo Cube

TA-supplied Thermo Cube1 Model 10-300. 
For UHP temp control set points above 10°C, recommend fluid 25% ethylene 
Glycol 75% distilled water with 1 oz. of TA conditioner added 
For UHP temperatures below 10°C, 25% Ethanol and 75% distilled water 
with 1 oz. of TA conditioner added. 

1. Filling the Thermo cube reservoir with 100% distilled water will damage the heat exchanger at 10°C and 
lower temp set points.

Low Temperature Cooling 
Accessory – Customer-supplied

Customer-supplied refrigerated and heating Circulator and appropriate 
circulation fluid such as silicone fluid.
CANNOT USE WATER AS CIRCULATION FLUID WITH THIS 
CONFIGURATION. 
The supply should be 5°C below the minimum required temperature at a 
minimum flow rate through the system of 0.2 L/min (12.2 in3/min)

Low Temperature Cooling 
Accessory – Vortex Cooler

TA supplied Vortex Cooler
Air: Clean, dry, oil-free compressed air 200 L/min at 552-690 kPa gauge
(80-100 psig). The dew point should be -30°C or better.

Low Temperature Cooling 
Option with Circulator (For 
temperatures below 10°C)

Requires Circulator and appropriate circulation fluid such as silicone fluid.
CANNOT USE WATER AS CIRCULATION FLUID WITH THIS 
CONFIGURATION. 
The supply should be 5°C below the minimum required temperature at a 
minimum flow rate through the system of 0.2 L/min 
(12.2 in3/min)

Low Temp/Vortex Cooling 
Option with Vortex Cooler

Air: Clean, dry, oil-free compressed air 200 L/min at 552–690 kPa gauge 
(80–100 psig). The dew point should be –30°C or better.

Dimension Width (diameter): Dewar 46 cm (18 in), Feet 79 cm (31 in), Height: 107 cm (42 in)

Weight 46 kg (101 lbs.) – empty; 87 kg (191 lbs) – full

Power 
Requirements

120 Vac at 0.9 kW, 47-63 Hz or TA transformer, P/N 546153.901 for 220 VAC 
environments.

Laboratory
Requirements

GCA is refilled by connecting to a 160 L liquid nitrogen tank with pressure of 150–170 kPa 
gauge (22–25 psig)
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Circulator (Julabo FP35-HE)

(Used with Asphalt Submersion Cell. Must be placed on floor.)

Liquid Nitrogen Dewar

(Used with the DHR/AR Rheometers ETC accessory for sub-ambient operation.)

Air Chiller System (ACS-3) and ETC Chiller Panel

(Used with the DHR/AR Rheometers ETC accessory for sub-ambient operation)

Dimensions Width 30.5 cm (12 in), Height 64 cm (25 in), Depth 43 cm (17 in)

Weight 34 kg (74 lbs.)

Power 
Requirements

115 VAC @ 60 Hz (14 Amp); 230 VAC @ 50 Hz (12 Amp)
15 Amp with receptacle and plug

Laboratory 
Requirements

Same general environmental requirements as rheometer. 

Fluid 
Requirements

Distilled or deionized water.

Dimensions Width 46 cm (18 in), Height 128 cm (50 in) (Unit designed to sit on floor.)

Weight 48 kg (106 lbs) - Empty
96 kg (211 lbs) - Full

Power 
Requirements

None

Laboratory 
Requirements

Same general environmental requirements as rheometer. 
Dewar is refilled by connecting to a 160 liter nitrogen tank with a pressure of 
150–170 kPa gauge (22–25 psig). A transfer hose is required for filling the Dewar and is 
not supplied by TA Instruments. 
The diameter of the standard 160 L external LN2 tank is approximately 51 cm (20 in). 
Allowance should be made for the tank to stand at the flow meter assembly (left) end of the 
table.
If the cryofab 50 L dewar is purchased from TA Instruments, TA does not supply the fill 
hose.

Dimensions of Air Chiller
Without Chiller Panel
With Chiller Panel

(H x W x D)
112 cm (44 in) x 37 cm (14.5 in) x 56 cm (22 in)
112 cm (44 in) x 52 cm (20.5 in) x 56 cm (22 in)

Weight of Air Chiller
Without Chiller Panel
With Chiller Panel

118 kg (260 lbs)
134 kg (295 lbs)

Dimensions of Chiller Panel Height: 86.4 cm (34 in)
Width: 48.3 cm (19 in)
Depth:38.1 cm (15 in)
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Weight of Chiller Panel 18.2 kg (40 lbs)

Cooling Gas Requirements Gas: Air or nitrogen
Pressure: 7 bar (100 psi)
Flow rate: 200 1/min
Dew point: Must not exceed the ambient air temperature by more than 
5°C

Power Requirements 220–230 VAC
50 Hz or 60 Hz (refer to the serial number plate on the rear of the unit); 
Nominal 9.3A, Max 12A
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ARES-G2 Rheometer / RSA-G2 DMA
The following table lists requirements for the ARES-G2 and RSA-G2. The specifications below apply to
both instruments, unless noted otherwise. 

Dimensions Test Station: Width 46 cm (18 in), Depth 56 cm (22 in), Height 104 cm (39.37 in) 
Power Supply Enclosure: Width 32 cm (12.5 in); Depth 48 cm (19 in); 
Height 34 cm (13.5 in)
Environmental Supply Enclosure: Width 32 cm (12.5 in); Depth 48 cm (19 in); 
Height 11 cm (4.5 in) 

Weight
ARES-G2

RSA-G2

104.5 kg (<230 lbs)
 95.3 kg (<210 lbs)

Power 
Requirements

Line voltage connects into power supply enclosure via 8 ft (2.44 meter) power cable

If Forced Convection Oven1:
180– 264 VAC, 47–63 Hz, and single phase
Dedicated 20-amp outlet

If APS, Peltier Plate, or Sealed Bath and NO FCO.
90–264 VAC, 47–63 Hz, and single phase 
Dedicated 15-amp outlet

1. The image below shows the L6-20, 220 VAC plug provided with the FCO for US customers. Customers 
should supply an L6-20 outlet.

Laboratory 
Conditions

Temperature 15–35°C
Relative Humidity <80% non-condensing
Instrument should be located in a dust-free, vibration-free environment, away from 
exposure to direct sunlight and drafts. (Pollution Degree 2 Environment)
Maximum Altitude 2000 m (6560 ft)

Laboratory 
Requirements

The air supply should be 100 psig (.69 MPa) and able to sustain a flow of either 4 scfm 
(115 L/min) for units without an FCO or 9.5 scfm (270 L/min) for units with an FCO.
Air must be clean, dry, oil-free instrument quality. The dew point of the supplied air should 
be –10°C or lower. TA Instruments recommends purchasing the air dryer to account for the 
necessary dew point and air quality.
The suggested minimum work table size is 87 cm x 165 cm (34 in x 65 in).
Access of 61 cm (24 in) behind the table is recommended for service and maintenance.

For instruments with an FCO requiring N2 gas for the sample medium, set the N2 
gas supply pressure to 70–125 psi (0.48– 0.86 MPa) with a flow rate of 
100 L/min (3.5 scfm). In this situation, air flow can be reduced to 170 L/min 
(6 scfm).
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ARES-G2 / RSA-G2 Placement

The ARES-G2 / RSA-G2 base system consists of the Test Station, Power Supply Enclosure with at least
one Environmental Supply Enclosures stacked on top, and the Host Computer.

Select a location for the system with adequate floor space and a solid, rigid laboratory bench that is level.
The bench should be able to support at least 182 kg (400 lbs) of equipment and have a minimum depth of
76 cm (30 in). Width will vary depending on how the instrument is placed. 

The Test Station must be within 2.44 m (8 ft) of the outlet of the air dryer assembly.

The Power and Environmental enclosures can be placed on the floor. A 2.44 m (8 ft) umbilical cord
connects the rear panels between the Test Station and Power enclosure. The Power enclosure must be
within 2.44 m (8 ft) of the line voltage outlet. 

The Forced Convection Oven (FCO) may be placed on either side of the Test Station tower depending on
the laboratory setup. Leave at least 41 cm (16 in) on the side of the Test Station the oven is mounted to
allow the oven to be swung open. The FCO must not come within 6 inches of any wall or flammable
surface when it is fully open. The rear of the oven must be within 1.8 m (6 ft) from the rear panel of the
Environmental enclosure in order to connect the cable between the oven and enclosure.

ARES-G2 / RSA-G2 with Forced Convection Oven Placement Layout

The LN2 Controller is placed about 0.6 m (2 ft) from the side of the oven. The Liquid Nitrogen tank should
be near the inlet side of the LN2 Controller. A 0.9 m (3 ft) hose is provided to connect from the tank into
the LN2 Controller.

The Chiller, for use with the Forced Convection Oven, needs to be placed on the floor near the rear port of
the oven. A flexible transfer line is provided to connect from the outlet of the Chiller to the inlet of the
oven.

Optional N2 gas source is for temperatures above room temperature only. LN2 
controller is for use to reach sub-ambient temperatures.
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Circulators should be placed on the floor near the ARES-G2 Test Station. Included with the instrument is
1.8 m (6 ft) of hose to connect from the circulator to the Bath or Peltier mounted on the Test Station. 

ARES-G2 with Peltier or Bath Placement Layout

CAUTION: The test station must be located on a rigid and reasonably level 
surface to prevent erroneous sample results from vibrations due to table or floor 
movements, outside noise or people hitting the table or the instrument. For the 
most sensitive measurements we recommend placing the instrument on a 
separate marble table.
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Miscellaneous Rheology Accessories

Liquid Nitrogen Controller
(Used with ARES-G2 and RSA-G2. Optional for Forced Convection Oven.) 

Dimensions Width 28 cm (11 in), Height 58 cm (23 in) 

Weight 14 kg (30 lbs) - Empty
15 kg (33.5 lbs) - Full

Power 
Requirements

Supplied by FCO Controller.

Laboratory 
Requirements

Same general environmental requirements as main instrument (Test Station).
The FCO can be mounted on either side of the test station tower. The LN2 Controller should 
be placed on the same side as the FCO.
Requires a user-supplied 160 liter (or larger) Liquid Nitrogen tank with a pressure of 95–
150 kPa gauge (14–22 psig). LN2 pressure in excess of 207 kPa gauge (30 psig) may cause 
damage to the LN2 Controller. Most in-house supplies of the LN2 tends to contain a certain 
volume of gaseous nitrogen (N2), which occurs due to heating in the supply line (near the 
LN2 Controller) before delivery to the LN2 Controller. Keeping the supply line short, and 
providing adequate insulation will minimize gaseous Nitrogen build-up in the supply line. 
Failure to observe this caution may cause the LN2 Controller to malfunction frequently.

A 0.9 m (3-ft) supply hose is provided for connection between supply tank and LN2 
Controller.
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Air Dryer
(Recommended for use with ARES-G2 and RSA-G2.)

Dimensions Width 36 cm (14 in), Height 27 cm (10.5 in), Depth 10.5 cm (4 in)

Weight 3.2 kg (7 lbs)

Power 
Requirements

None

Laboratory 
Requirements

Same general environmental requirements as rheometer. 

Inlet air: 0.7–0.9 MPa (100–130 psig); air temperature ~ 20°C
The air dryer MUST be mounted upright on the wall within 183 to 244 cm (6 to 8 feet) of 
the air source.   The center holes of its two mounting brackets are 22.3 cm (8.8 in) apart. 
The air source into the dryer should be oil-less compressed air.
The customer should provide a means to connect to a 3/8” NPT male connector on the inlet 
hose of the air dryer (provided by TA Instruments). The customer should provide a gauge to 
monitor the 0.7 MPa gauge (100 psig) source of clean dry air into the air dryer. The air 
supply from the air dryer must be regulated to provide 0.55–0.6 MPa gauge (80–90 psig) 
into the test station. The flow rate will vary depending on type of environmental system. 
Air dryers are designed to remove moisture from the air. They are not designed to remove 
water from the air. If you have excessive moisture levels that result in the immediate 
condensation into water, the membrane type air dryer may get over saturated and cause 
damage. Your maintenance personnel should install an external 'Water Trap', before feeding 
the air into the Air Dryer. 
Inlet air should be at Relative Humidity of 70% or less, at RT with particle size of 5 microns 
(0.0002 in) or less.
An 2.44 m (8-ft) hose is provided for connection from outlet of air dryer regulator to the 
rear of the test station.

CAUTION: The air into the instrument must meet the above requirements or 
damage to a major component within the instrument may occur. Such damage is 
NOT covered by Warranty, written or implied.
Page  23



ACS-3 Gas Chiller System and FCO Chiller Panel
(Used in conjunction with Forced Convection Oven (FCO) for the ARES-G2 and RSA-G2.

Circulator (Julabo FP35-MC)
(Used with the Sealed Bath with the ARES-G2. Must be placed on floor.)

Dimensions of Air Chiller
Without Chiller Panel
With Chiller Panel

(H x W x D)
112 cm (44 in) x 37 cm (14.5 in) x 56 cm (22 in)
112 cm (44 in) x 52 cm (20.5 in) x 56 cm (22 in)

Weight of Air Chiller
Without Chiller Panel
With Chiller Panel

118 kg (260 lbs)
134 kg (295 lbs)

Dimensions of Chiller Panel Height: 86.4 cm (34 in)
Width: 48.3 cm (19 in)
Depth:38.1 cm (15 in)

Weight of Chiller Panel 18.2 kg (40 lbs)

Cooling Gas Requirements Gas: Air or nitrogen
Pressure: 7 bar (100 psi)
Flow rate: 200 1/min 
Dew point: Must not exceed the ambient air temperature by more than 
5°C

Power Requirements 220–230 VAC
50 Hz or 60 Hz (refer to the serial number plate on the rear of the unit); 
Nominal 9.3A, Max 12A

Dimensions Width 30.5 cm (12 in), Height 64 cm (25 in), Depth 43 cm (17 in)

Weight 34 kg (74 lbs)

Power 
Requirements

115 VAC @ 60 Hz (14 Amp); 230 VAC @ 50 Hz (12 Amp)
15 Amp with receptacle and plug

Laboratory 
Requirements

Same general environmental requirements as rheometer

Fluid 
Requirements

Recommended 50/50 mixture of distilled or dionized water/laboratory-grade
ethylene-glycol for a circulator temperature range of -5 to 105°C.

CAUTION: Only laboratory-grade ethylene glycol should be used in circulators.
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Additional Circulators
(Used with the Peltier Plate with the ARES-G2. Must be placed on floor.)

ThermoCube Peltier Cooling Circulator Model 10-300

Dimensions Width 28 cm (11 in), Height 32.4 cm (12.75 in), Depth 32.4 cm (12.75 in)

Weight 12.7 kg (28 lbs)

Operating Range -5 to + 65°C

Power 
Requirements

115–230 VAC @ 50/60 Hz (3.5 Amp)
15 Amp with receptacle and plug

Laboratory 
Requirements

Same general environmental requirements as rheometer. 

Fluid 
Requirements

80/20 water/alcohol mixture (recommended)
Page  25



TA Instruments Offices
For information on our latest products, contact information, and more, see our web site at: 
http://www.tainstruments.com

TA Instruments — Waters LLC
Corporate Headquarters
159 Lukens Drive
New Castle, DE 19720
USA

Telephone: 302-427-4000
Fax: 302-427-4001
Email: info@tainstruments.com
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